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Perche Liferay?

PORTLETS

« Collaboration « Portal Admin

« Social Networking

= Web Content

« Document Management

& Presence

« Portlets * Themes » Gadgets
« Third-party Intergrations
* Hooks « Layout Templates (SOLR, JBPM, Documentum,

Droolz, etc.)

« Service Builder
« Liferay IDE

« Liferay Taglibs
« Liferay Alloy Ul

« Liferay Theme Engine

« Liferay Remoting

« Liferay Portlet Container (JSR168 / JSR286 / WSRP 1.0 / WSRP 2.0)

(Java/Web Service)

« Liferay Service Interface (Spring)

Enterprise Service Bus

« Content = Portal « Personalization
. . « Reporting / Bl . -
Collaboration (Jasper Reporting Engine) Security
« Soci « Tagging .
Sccial (Folksonomy, Taxonomy) User
« Auditing/Monitoring N &%’5"2:1@ - « Scheduling
« Analytics * Rules « ClusterLink

Message Bus & Events

A

Mashup Capabllities
Facebook, NetVibes,
Widgets,
iGoogle/Gadgets,
Shindig, RSS/Atom

Rich Clients
jQuery, JSF, JSP, Flash,
PHP, Ruby, Velocity

Web Services
SOAP, JSON, HTTP,
REST, Atom, Java API

LDAP AUth/SO0O
Microsoft, Open SSO,
Apache,0peniD, Novell,
NTLM, Fedora, CAS,
Open:DAF, Sitemindert

Persistence (Hibernate, JPA)

" W
.

BPMS Legacy Content SAP,

" "
] O

ega .
(BPEL, JPDL) Apps Stores Other ERP
(JCR, CMIS,
Documentum)

Mail Server Chat Server

A
L]

DB2, Ingres®, MySQL, MS SQL

Servers, Oracle, Postgres, more

*Open Source

*Portal Architecture
*Enterprise Platform
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Liferay is Open Source

~6 Million Downloads

940K+ Deployments

46,986 IDE Downloads

234,400 Messages
+=.11 Amazing Years

< y{.‘_“(
DG |
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Q Ry S%C‘%' (.) ﬁéce Marketplace Apps

Service Build ALLO\( [‘*ﬂ

USERINTERFACE

Plug-in
Architecture

Developer Studio

Enterprise integrations, Web integrations,

SOAP, Web Services Users Groups & Roles Mashups, REST
Identity and Permissions

Site Management

Content Workflow h facebook

:LegacySystems F Collaboration Auditing
Social Rules

A,
l |*: LIFERAY]

Proprietary SW

Content Stores

All Major Web Containers All Major Databases

l All Major Operating Systems



Liferay Portal Platform

( Collaboration ) ( Collaboration )
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Enterprise Leader

Gartner

60%

45%

30% 58%

15%

0%
Sharepoint

48%

Oracle

Liferay garners as much interest in the
portal market as its far larger
competitors.

Inquiries with Gartner clients

47%
42%

= 13%
° 9%

Liferay Websphere OpenText SAP JBoss
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Enterprise Leader
Magic Quadrant

Figure 1. Magic Quadrant for Horizontal Portals

Gartner =

Mo
“Liferay's open-source e
success is due to its : w
sharp focus, functional Red Hat (JBoss op,,m::em
excellence, and ease of % Toco Sovar Ba;ﬁ%ﬁz&.‘?&'?p“wm’
development and DotNetNoke sgo K
deployment, as much as
cost.” .

ey —

— 1 completeness of vision F—p»
As of October 2011
Source: Gartner (October 2011)
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Liferay — Our Company

* Global commercial Open Source company since 2004

e 300+ Employees worldwide

* 200%+* revenue growth in 201 |

"4 LIFERAY.
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Global Presence

Liferay Presence

@ Partner Locations

WWW.LIFERAY.COM == LIFERAY.



Liferay — Italian Partner Ecosystem

e R

* Formazione ‘i‘
%\

LIFERAY. ’ ‘*}

Italian Partner Ecosystem
ympeienza - -
Prossime coperture -

Ceniri di cc
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Liferay come ....

.. Piattaforma per la Gestione di Siti

.. Sistema Gestione Documentale

.. Sistema per la Gestione di Contenuti VWeb
.. Piattaforma di Produttivita Aziendale

.. Piattaforma di Sviluppo, Integrazione e Deploy

NEW FEATURES IN 6.1

WWW.LIFERAY.COM |_| FE RAY



Piattaforma di Gestione Siti

Power User
and
Productivity

Architecture
and
Integration

Systems
Administration
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Modelli di Siti Dinamici

1. Gli amministratori dei siti determinano quali aree delle
pagine vengono controllate dal template / modello

2. | siti mantengono una connessione con il loro template

3. Quando viene fatta una modifica a un’area controllata dal
template, questa € automaticamente applicata a tutti | siti

& 7;9 Add ¥ manage site Content 3¢ || [LestTost Gonow)
| =l I- - 2! Control Pane Bra Web Content
e al
B Web Content 2
i 1) Document Library
& Manage ¥ Edit ¢ ‘ Vieb Cortentcan b any conletyou would ke 0 aad wa s suenasascies.arA0.cra [T
(B Image Galles Y & news ilem. Administators can manasge conlent, as well o assign user 1les and penmissions. F
liferay.com B3] Bookmarks Users may add, edit, approve, or view content depending on their role. |
‘ | Calend: |
| Page 2 |
(&= Messag
— \Pi| Blogs T RN
[im| Page Layout g —
Y | == geos
er — g ) oo Add | Permissions
[y Page Personalizations @ sonw
(= Tags
a &= Categoriea Xpks M
N .. Site Pages ow  ® Sodal
| (=D, = =
' o S
= o pate
& Site Content not o
) L Tad 224 TR tions
adem L
35 Site Settings iManage “
o

Fate i cambiamenti una volta soltanto, per ottenerli in migliaia di siti!

WWW.LIFERAY.COM = LIFERAY.




Siti Personalizzabili dall’Utente

Gli amministratori dei siti rendono certe aree delle pagine,
personalizzabili dall'utente finale.

7l Home - iifcray com x ™ Home - life: ay.com x

& @ & @ localhost 3050/group/ 7eogs/home & @ ©localhost:3030/croup/7cogs/home 7 =N

¥ JAda¥ manage¥ | ¥ EditcControls ¥  ©addv¥ . “manage¥ | »f EditControls M Goto ¥ Tes! Test (Sign our) =

f 7 COGS INC. g% 7 COGS INC.

| Weray.com | 7Cogs,inc. ; Home | mreray.zam | Trogs, ne Home

-/ Customizable ~ Customizable &

f |
=: ¥ Customizable w | ~ Customizable &

s, Users with permission Lo customize Lhis page will be able

iy to customize those sections marked as customizable

the Or  Adminst-alor can 2dit them. To

“defreal .  oher
izafion Rolea can bo creatod in ths Cartrol

x
In Lrersy you can crests 33 many orcanzstions and
COMMUES 25 You wa s own
UIRIC: ANC PAVAIE DAQES. NI DACES CaN DA LSed
Al I A

Privae pag b far as only g A

tho merbers selonaina o thet ramrzation of Customization Per Column
community ¢an asc tem.

lf%ele
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Staging Versionato

» | o Edit Controls f Gotovy | Julio Camarero (Sign Out)

E\-Nl Staging

Page Home was last published from Main Variation. ( By Version: 11004 )

®© 12 Hours ago by Julio Camarero

B@@k St@ge HOME  AUTHORS  BOOKS

Book Store Home

Welcome to the Book Store! Find the latest

voca Bug o # The Alchemist
Last Auts The Alchemist details the journey of an Andalusian shepherd boy named Santiago. Santiago, believing a
B Last Authors recurring dream to be prophetic, decides to travel to the pyramids...
View »
# Paulo Coelho # The Two Towers
Paulo Coelho was born in Rio de The Lord of the Rings is composed of 6 "books", aside from an introduction, a prologue and 6 appendices.
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Staging Versionato

» | o Edit Controls f Gotovy | Julio Camarero (Sign Out)

E\-Nl Staging

Page Home was last published from Main Variation. ( By Version: 11004 )

®© 12 Hours ago by Julio Camarero

B@@k St@ge HOME  AUTHORS  BOOKS

Book Store Home

Welcome to the Book Store! Find the latest

voca Bug o # The Alchemist
Last Auts The Alchemist details the journey of an Andalusian shepherd boy named Santiago. Santiago, believing a
B Last Authors recurring dream to be prophetic, decides to travel to the pyramids...
View »
# Paulo Coelho # The Two Towers
Paulo Coelho was born in Rio de The Lord of the Rings is composed of 6 "books", aside from an introduction, a prologue and 6 appendices.
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Staging Versionato

¥ (@©Addv o Managev |/ EditControls f Gotovy | Julio Camarero (Sign Out)

Christmas ¥ Main Variation v  Saint Valeniine's Day » ¥+ Manage Site Pages Variations

Main Site Pages Variation of Book Store | 3 Pages
Current Page: Home

Fg Version:13011 [ Status: Draft & Mark as Ready for Publication [Mesit ciicl CHCl AL

HOME AUTHORS BOOKS

- Book Store

Book Store (Staging) Home

Big Asset Publisher Hjp Last Books

© AddNew » |
# The Alchemist
1 Edit
# Paulo Coelho IEI Sl The Alchemist details the journey of an Andalusian shepherd boy named Santiago. Santiago, believing a
recurring dream to be prophetic, decides to travel to the pyramids...
Paulo Coelho was born in Rio de View »
Janeiro, Brazil.[1] He attended a Jesuit -
school. As a teenager, Coelho wanted
to become a writer. Upon telling his
mother this, she responded with... @ The Two Towers

View »
The Lord of the Rings is composed of 6 "books", aside from an introduction, a prologue and 6 appendices.

The novel was originally published as 3 separate...
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Mobile

« Supporto nativo migliorato per iPhone, Android,
iIPad, ...

Carrier = 3:06 PM (o

Enterprise open source portal and collaboratio...

* Riconoscimento Dispositivi (WURFL) | "
" LIFERAY.

Mobile support

* Regole di Riconoscimento Dispositivi

personalizzabili

Products

 Framework per | temi con /layouts responsivi

Services

— Permettono a una singola versione di una B
pagina di essere perfetta su dispositivi di e
tutte le dimensioni

— Per un esempio di utilizzo, vedere
liferay.com

WWW.LIFERAY.COM = LIFERAY.



Faceted Search

.4 Search Results- Search- |

@ @ [Olocalhost:8080/wcb/gucst/products?p_p_id=3Sp_p_hFccyclc=D&p_p_statc:maxim\zcd&p_p_modc:vicw&_z_struts_octk*| [ 8

Welcome Search

liferay.com  Search

Y.

Enterprise. Open Source. For Life,

Blogs

Farums News Aboul

WWW.LIFERAY.COM

-, Search 4 Return fo Full Page |
B Eeten v [0
. \ Completed in 0.028 seconds.

{ Everything Showing 1 - 20 4 First 4 Previous = More b

& Document Library Document (2

- Web Content (17) ’

3 wiki Fage (1) # Banner Web Content
iferay 7coos () Topic: Products

Any Tag @ Products Button Vit Canipnt
7cogs (9) ffcray Jcoas IaTop‘c: Products
ix-998

i N @ Blogs Button Vi Contpot

liteay (6) iferay Tcoos (2D Topic: Products

features (3) fferay Tcoes |2 Topic: Products

products (3) @ Forums Button Weh Cantent

documents (1) Woray 'S Tcogs (D) Topic: Droducts

enterpise (1)

front (1) @ Home Page Intro Mt

home oage (1) » front () Topic: Products

sharing (1

bl @ Cog Network Ad Web-Conteat
o> Weray &> enterprice fﬂTopic: Sroducte

(=) Any Category Web Content

e @ Products Banner
Tcogs '® ix-998 [T Topic: Products

© Ary Time SR

Past Hour ' LIFERAY WEST COAST SYMPOSIUM

Past 24 Hours @ Products Landing Intro Info

Past Week % products () Topic: Products

Past Month

Pasl Year @ Products Catalog -

N =

: LIFERAY.



Gestione Documentale

Architecture Power User
and
and Productivit
Integration roductivity

Systems
Administration
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_ _ B
Interfaccia Utente Riprogettata

Library

0 Add v | SotBy v |Actions v Manage v Search
i Docunents Home Showing 9 resut Add@ | Actions © | @ sot
— -
© Recent Documents i 1 e
R - Shoving 7 zs.lls.
& My Dccuments () Down{l;ad(‘lm..‘k) Whats Corming # WCM
SalesReport ] Ean - Agenda Spanish Symposyum
] Move S Lorem psum colcr sit amet, consectetur adipis ¢ ng elit s2d do eiusmod tempor- incidicun: u: labcre =t dolore magra
[ Marketing Video Sevelopmantppl Whets Coming ir WCN - Raymond — aliqua. Ut en'm ad minim veniam, quis nostrus exercizatior ulamoco ‘aboris nisi L1 zlicuiz ex 2a commodo conseguat.
i Lock Auge pdf — Du's aute iru-z dolcr i~ reprenerde-it n voluptate ve it essz cil um dolore zu ‘ugiat n.llz parigtu- Excapreursnt
pr Permissions occaeca! cupidata: non proident sun:in culza qu officiz de: 2 estlaoorum
o
7 Delete
—_— to——nem -
5= — e \
[Si=1
l o= S Automated and Manual Testing Overvisw.doc
rs -: — Lorem 'psum colcr sitamet, consectetur adipis cng elit s2d do ei.smod tempo- incidicun: u;
=] = afiqua. Ut en'm ad minim venizm quis nosiruz exesdization u/lamco ‘aboris risi i gliquiz ex @ Dawnload (
= —_— = Du's aute irurz dolcr i~ reprenerderit 'n voluptate ve'it essz cil um dolore fugiatnullz pai — £
6.1-LP - Web Form Plugin - screer-captire-11.png Finel EU Symposium Erochure.pdf occaecs! CUpidata: non proident. sun: it culza qu oicie dzssrurt molli: anim 12 estlanorum =
Larguage Translations.xis
| Move
— - - 1 Unlock
Permissions
— | [METSY EE Archil & Hardware Reqy pal =
Lorem psum colcr sitamet, consectetur adipis ¢ ng elit, s2d do eiusmod tempor indidicun:u. 1 Delete
aliqua Uten'm ad minim venizm. quis nostrug exercization ullamco ‘aboris nisi ul gliguiz ex SACONMMoNOCoNSeqUar.
Du's aute iru"2 dolcr 17 reprenerderit:n voluptae veiitesss cilum dolore u -ugiat nulla paniaty” Excapieursnt
Developers Marksting Whitepapers occaecz! cupidata: non proident, sun:i- culza qu officiz dzszrurt molli: anim iz estlasor.m
Showing 9
O ee— S

Unificazione fra Documenti e Multimedia

« Amministrazione Unificata

« Media Gallery per una gestiona ottimizzata per |l
multimedia

WWW.LIFERAY.COM
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Preview Automatiche

Whats Coming in WCM - Raymond Auge.pdf

[ Edit |[®) Move | % Lock | i Permissions

== —‘ o Uploaded by Test Test, Wed May 25 09:39:30 GMT+02:00 2011
wrcmmeuwcs ™ Presentation by Ray Auge for the East Coast Liferay Symposium 2011
- Tags: « webcontent =+, |feray

What's Coming in WCM

Raymond Quge

e

Version 1.1

« Back

o By TesiTes), Wed May 25 10:11:31

GMT+02:00 2011
& Download (572 .0k)
Get URL or Webdav URL

& Status Approved

~ Version History
Version Date Size

52511

11 8:11 572.0k
AM
5725111

10 733 572.0k
AM

Status

Approved

Approved

Video
Immagini
Suoni

PDF
Word

OpenDocument

WWW.LIFERAY.COM
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Collaborazione Estesa

« Tipi di documenti personalizzati in modo che l'utente utilizzi
concetti familiari:

— Documento Offerte O] Add v |sorsy v|.

— Eventi, Manifestazioni, etc. showings Gy fokier
— Informazioni Marketing @ RaceitBooumants = ::::';m
& My Documents %
— Promozioni Turistiche —— g Repository
— ECC_ ([ Marketing Video :, ales Report J
L") Marketing Video

Actions @ | Add @ | SortBy @ | Manage @ I SRR
fi Documents Home Doct @) Cancel Checkout

£ Recent Documents Showing 3 results.
& My Documents

[} Basic Document

L7 Image

[ video

Check in & Check out

WWW.LIFERAY.COM |_| FE RAY



Collaborazione Estesa

Ogni tipologia avra automaticamente informazioni specifiche e
metadati automatici e manuali per arricchire il documento

Document Types

Metadata Sets

New Metadata Set

Name (Required)

]Dates & Location

New Document Type > Details
Name
iSales Report
Start Date
Description |05/25/2011
\Document used to |
End Date
|05/25/2011
2
Location *
Metadata Sets
Name
Dates & Location €5 Remove
Audit Data €5 Remove
@ Select

Save | Cancel |

WWW.LIFERAY.COM

Save | Cancel

@ Add Field 258 Fleld
Settings

) Boolean
[* Date

= Decimal
=] Integer
= Number
O Radio
—= Select
=] Text

=] TextBox

&
N LI L.IN \le



Repository Multipli

 Interfaccia utente unificata che gestisce multi
Repository addizionali:

Add v | SortBy v | Actior

— Liferay ing = Folder

_ CM'S o Document

— Sharepoint (EE) l S—

— Documentum (EE) "7y Sales Report
L] Marketing Video

agenda.pdf

WWW.LIFERAY.COM =..= I_I FE RAY



Liferay Sync

* Accesso offline a tutti i documenti!
« Client per
—~Windows

—~Mac

—iIPhone
—Android (Presto)

WWW.LIFERAY.COM ®: LIFERAY.



Applicazioni iPhone

Carrier =

* Release to refresh...

Engineering
/21/11 437 PM

-8 moaE> 8

—

Legal

&~ Documentation

Liferay Features.txt
9/21/11 4:42 PM 16B Engineering

Liferay Trends.pdf

~— Legal
~-— Marketing oo 11 435 PM

)/21/11 4:36 PM

K
L
M
N
0
P
Q
R
S
T
U
Vv
w
X
Y
r 4

Liferay Features.txt
Liferay Trends.pdf

1

4 Folders, 2 Files

N<XE<C-VIPOOZAPER <~ TN MOO®>» it

Cancel

Liferay
Liferay

A

VW VW VW.LIFEKAT.CUM 7 i-.= LI I_ERAY0




Piattaforma di Social
Collaboration

Power User
and
Productivity

Architecture
and
Integration

Systems
Administration
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Forum

» Supporto per editor Full HTML e editor BBcode

migliorato

« Maggiori possibilita sui template per le notifiche

* Vista Question & Answers

Forums v | Epe——

0 rarkanl Racas! Parrs m

Catnosic=

L (5% F1IFTTTRERE 3 BN STU TR 0T EENL) 18/3%
Tesoce sl oy oo gelling pour e erdranrel s = a0 o cof gaisdr issL s wi Jslabuse wosbupps wrd sad

are

2 Wsiny L=ty 4335 17346

SACEFANA VHAnAIY s pe 1 s r e pe A3l MANECATECT CPDR arE | CATmnn Sial e of g pee £ vilas
wn A e LT peirt al v e

3. Devalaprant 7357 zane
=eleartapcs xasiapmag arve aadixny 2e23nq ey ret 225 oed sngmin =510 =reonmeat

Tname Devalopmant ] 230

¢ cxninnes anee anch az oo vnanly e o heve Gotd g

eI e o aun, ples 2 R oc o e insBisho o gy,
Y Peetal bramman) e T
=etess Liopies nleerdt on s ooe 1y WA= ol Jaeey, Ssositsulidel Laoriese b, Aibeele,
i Thee Panty Applizacon immnagragiog EEX] 1200
S 22 AR T A il Pur S L siiees, o Eepons © S0 ool duplilive s
T ALAGAGTCE & 201 FRAtine Racm akts che] 1177
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Blogs

« Collegamento piu facile ad altre
voci del Blog (ed anche ad altri
tipi di contenuti)

« Supporto per abstract di articoli
indipendenti

 (Condivisione Social Network
migliorata (twitter, facebook, ...

Blogs

Jluyz »

cxpanded guide tor Ext plugins published within the Ueveloper's Guide

decamenadon extyiugin
©; By.largsFerer 1
= L

2 kAt L pemissians [ Delete

InF ot N2 mast iniareshng mpmvements af - sy B nr develapess s hat fe plugin iTRsinet e 133 mpeeven

sonsideraby Tos exancie, the yoo< pliginsate row Tuch mote ooweriul and alow =

mzing s plation r a very

weinlaingb.away. A'zo, the cld extension erwroarert hasbeer movedinsde 52 pluging SD< a5 wha 2re knowr as Ext

sluvirs.

aunishec it the decuneniztion pages.

AFz ounlisning cur row st of cocumeniation peges and aaccilly the nzw Doveloper’s Cuide we'vs bocn asked formoc
fled coc1 menfEtnT Ahal FxI phignR VWeve heen woersmgan tAurng N2 iast = days ane 1S naw ready and

tineludzs inbmaion abeut =aw fo mgraze ar cox environme: e3well a3 1w B cevelos and ccploy it We hope yau like

t

|¥5) Blags

New Social Bookmarks in Liferay 6.1

This is a test entry to show the new sozial bookmarks in Liferay €.1

F=-+X

Search Add Blog Entry Permissions

a‘ B\ ) narer 0 Comments Flag
o @
Wiweet 0 1 +1 ‘0 0 :Iéigrg
@E‘flmk»,szw l.‘1Ci<.'.w:.us“Z 2 0 Technonti %

WWW.LIFERAY.COM
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WIKI

 Editor WYSIWYG Creole

 Nuovo parser super veloce
per massima scalabilita

Wlkl 4| Main | Poposais Search

=

New Page @ Add Chilc Pags |_:_| Edit £ Print | Datalls

Wezlcome to the Liferay Wiki Guide, ar online collection cf Liferay knowledge and know-how ccmpiled by both our own staff and
those in our community The 900+ articles that cumently reside in this wiki are the result of an organic free volunteer effort and we
Invitz you to participatz as well. Improve sxsting aticles or creats new ones orjust browse the Information © he p yoJ along
with your Li'eray proj=ci. Read the Wikl Guidzlines for scmz hints about Fow to create Lsefu’ pages.

You can also visit our Official Documentation pages for detailed information on versiors 5.2ad5.1.

A\

‘B Starting with Liferay

Irtroductory ertici€s 1or newWcomers Ic the _ii2ray world.

Instaliation

Articles abou: how tc irstall Li'eray Portal, how to set it up lo work with different application servers and databases and
how tc ashicvo a specific configuration.

* Ask questons about this topic in the forum

I

e

Development

Arlicles abou! how o dzvelop new putliels, exlend Liferay™ porllels and use he exlension envinonimenl

* Ask gucstons about this topic in the forum

s
N

¢ Using Liferay
Articles about how 1 use Literay Horial through the web Ul. (his includes porial administratior as well £s usmg any otthe
ircludzd out of the box portiets.

*_Ask questons about this topic in the forum

4" Customization

%)
\

Articles abou: how tc extend Liferay through configurzticn and custom zeticn. Also includes artices acouthow to craate
tremes, 10ow o Integraze third perty applicatiors, etc.

Ask yuesions aboul s opicin B forun aboul
* theme cevelopmen:

WWW.LIFERAY.COM
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Chat

 Altamente influenzata dai fedback e dai
suggerimenti dei clienti e dei membri della
comunita

* Integrazione con | server Jabber

* Miglioramento Scalabilita (Integrazione
Comet)

»

(=5

Online Friends (15)
E‘] Barrie Selack
. Craig Kaneko

g lvan Cheung
ﬂ Jason Head
Jenny Chen
! Jerry Niu
H John Ishihara
Jonathan Tanamachi
‘ Joshua Asbury
H JR Houn
Kenneth Dong
. Meesa Kim
Milan Jaros
n Nate Cavanaugh

Settings | Online Friends (15)

WWW.LIFERAY.COM
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Partecipazione prima della
registrazione

Come promuovere la partecipazione dei visitatori?

1. Permettergli di postare commenti o valutazioni senza
creare un account

2. L'utente sara in grado di creare un account in ogni
momento

— Tutta la partecipazione prima della registrazione sara
automaticamente assegnata a lui/lei (se lo desidera)

WWW.LIFERAY.COM = LIFERAY.



Gadget OpenSocial

* Riutilizzo di ciascun Gadget OpenSocial
— Disponibili a migliaia
— Connessione ai Social Network e a servizi online

WWW.LIFERAY.COM *: LIFERAY



Piattaforma di Produttivita
Aziendale

Architecture Powaerr‘dUser
i Productivity

Integration

Systems
Administration
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Liste Dati Utenti

e Gli utenti definiscono entita
personalizzate da salvare nel
database R
. . . 2010 ECS Road map Survey
’ G I I u te ntl d efl n I SCO n 0 m a SCh e re pe r Wiat features in lhe 2011 jvad map were of most impur tance L your viganization? =

catturare entita personalizzate e
interfacce utente per mostrarle.

— Aggiornamento settimanale ricettivita

Houw would you rank the impuitance of WCM in Liferay Portal

1 2 3 1 5 6 7 8 % 10
. . .- y
— Viste personalizzabili dall’'utente

. . . . * What features in the 2011 road map How would you rank the T

- O rd Inamen tl d atl were of most importance to your importance of WCM in
Timestamp organization? Liferay Portal |
— Riordinamenti Colonne 2 | 6/6/2010 22:44:12 Enterprise staging 10
3| 6/6/2010 22:44:12 Message Center cl

— Filtri di dati ? | '-

 Qli utenti creano maschere web
direttamente associate alle liste

W o~

=3
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Maschere Workflow

* Creazione Online di applicazioni basate su Maschere e
Workflow

* |Implementazione di Processi senza sviluppare
— Processi di approvazione Eventi
— Richieste di Aperture / Chiusure
— Procurement
— Processi di controllo per i dipendenti

WWW.LIFERAY.COM = LIFERAY.



Creazione di nuovi processi

Kaleo Forms

£+ X

New Process

Name (Required)
Sales Approval Processl

Description

EE Dther Languages (0) ¥

Entry Definition (Required)
© Select

Initial Form (Required) &)
© Select

Workflow
© Sselect

Workflow Task Forms
© Assign

Save ‘ Cancel

S Other Languages (0) ¥

« Back

WWW.LIFERAY.COM

[ | By
mE o

n

am
B
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Disegno Visuale del Workflow

Title

Symposium Registration Approval
» Details

Save Draft ‘

m Seftings
¢ O

Condition End

Start

Task

&

Fork

State

BS Other Languages (0) ¥

Source (Kaleo XML}

StartNode
| checkPresentation |

%Wml

Update Submission
/ppm ePresentation

|approve|

ﬁ (decine|

BookTravel

| completeBooking|

Decline
Approve

WWW.LIFERAY.COM

[ | By
[

D |
B L
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Assegnare le Maschere alle Attivita

L)

Close |

Inspect the task nodes to assign a
form template.

Property Name Value

Update Presentation Details

Name ApprovePresentation
Type task

< m |
Cancel ‘

Source (Kaleo XML)

StartNode
| checkPresentation|
L2 {review|r ity
Update Submission
|approve|
| completeBooking| BookTravel
Approve

'Appru vePresentation (Update Present

[deciine|

Decline

WWW.LIFERAY.COM
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Gestione Contenuti Web

Architecture Power User
and and
Integration Productivity
Systems

Administration
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Esperienza di Authoring Migliorata

Web Content Structures Templates

} Search l

Advanced »

© Add »

& Sales Report

Expire i Dele | 4 White Paper

Web Cortznt m Templates Feeds Recent

Creazione di contenuti Web secondo
tipologie specifiche per:

e Strutture
* Template
» \Valori di Default

g e * Aree di completamento

Delete |

L D Description

—— — Tutto secondo le diverse lingue del sito
E; c::;nssions
QAMWebComem
E;A&i‘lmphle
[5] View Templates
[ Delete

WWW.LIFERAY.COM
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Siti Multilingua piu facili

 Traducibili anche Titolo e Descrizione del contenuti web

« Traduzione di strutture e modelli dei contenuti web, categorie,

vocabolari, descrizioni dei ruoli, ...

« Usabilita ottimizzata per gestire contenuti web tradotti in varie lingue.

Frontpage content

J Permissions | (& View Histol

Structure: Default ] o3

Approved £

Template: None

Detault Language: 5 English (United States) & Change

T 4 — {Hungary)
Title (Required)
Frontpage content
Content
¥ A~ A B I U &
D@ e 38T e

%] Source = B FEOO SO

h reb conie:
o Searchable

X, i Catalan (Spain)

@

&) Add Translation v

Arabic (Saudi Arabla)
=2 Basque (Spain)

s Buigarian (Bulgaria)
[+l Catalan (Andorra)

&l Chinese (Taiwan)

la CzeCh (CzECh Republic)
== Dutch (Netherlands)

43 English (United Kingdom)
== Estonian (Estonia)

= Finnish (Finland)

L § French (France)

“\\ Gallegan (Spain)

= German (Germany)

Frontpage content

A new version will be created automatically if this
¥ content Is modified.

Save as Draft | Publish | Cancel

WWW.LIFERAY.COM
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L .
Pubblicazione Semplificata dei contenuti
nelle pagine

« Collegare facilmente i contenuti web alle pagine a cui
appartengono

« URL canonico per ciascun web content

[ Asset Publisher F -+ X 1
@ Add New » |
= >
# Frontpage content g Edit
ok gl www.mysite.com/-/frontpage-content

WWW.LIFERAY.COM = LIFERAY.



Relazioni fra contenuti

Book Store = -
,_/J J ) - = _/_, __

Iiferay.com ' Data  Authors & Stieg Larsson

[ Eat
@ The Girl Who Kicked the Homets” Nest Karl Stig-Erland Larsson (15 August 1954 — 9 November 2004), who
l;_l wrote professionally as Stieg Larsson, was a Swedish Journalist and
& The Girl Who Played with Fire [;] writer, born in Skelleftehamn outside Skellefted. He is best known for

writing the "Millennium series" of crime novels, which were published
posthumously. Larsson lived and worked much of his life in Stockholm. He
was the second best-selling author in the world in 2008, behind Khaled
Hosseini. By March 2010, his "Millennium serles” had sold 27 million
copies in more than 40 countries.

2 The girl with the Dragon Tatoo lsl

)i

¥ Related Assets

£ y
:2 Tags Navigation Q) Select » |
‘ Page Revision
T taas Type =
There are no tags. yp & Blogs Entry
Blogs Entry - Remove
LD Comments 6o Remove
Calendar Event o con botas Remove
L User e
Calendar Event = e Party Remove
o M ge Boards M g e
Web Content = po— pasando. Lo estamos haciendo. ¢ Remove
There are no categories. ] mage Safery, mage

Save as Draft ‘ F EJ Dynamic Data Lists Record

\Q Web Content

WWW.LIFERAY.COM — " | |FE RA?




Supporto migliorato alla Tassonomia

Categories
Edit Vocabulary x|
& Categories describe a set of vocabulary terms i can choose from when authoring content.
Name
- |Features B Other Languages (0) ¥
A abulary | Add Category | Permissions ‘
~ Description
Vocabularies
Departments
. n

Topic

- Permissions ‘
7 @8 Other Languages (0) ¥ ]
Version

Associated Asset Types —
Choose Asset Type
Wiki Page | ~ Required
- ' sla)
Choose Asset Type
‘ Calendar Event

~|| & Required

Save‘ Delete = Permissions Close

J )

— S —

WWW.LIFERAY.COM

—
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Piattaforma di Sviluppo, Integrazione e Deploy

Architecture Power User
and and
Integration Productivity

Systems
Administration
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SAML 2.0 Identity Provider

— Server Single Sign On Server per applicazioni onsite e cloud
SAML 2.0 Service Provider

—Connettere facilmente Liferay a un identity provider esterno
Directory LDAP Virtuale

—Accedere al repository degli utenti Liferay come se fosse un
server LDAP

Permettere alle applicazioni di connettersi a risorse di terze parti
senza chiedere all’'utente di rivelare le proprie credenziali.

Liferay ldentity Provider

WWW.LIFERAY.COM = LIFERAY.



OpenSocial 1.1

« Sviluppare | propri Gadget OpenSocial e portarli dentro
Liferay

* Creazione online di Gadget
« Combinare efficientemente Gadget e Portlet
— Comunicare fra Gadget e Portlet tramite di eventi

opensoctal

WWW.LIFERAY.COM *: LIFERAY



Produttivita di Sviluppo

« Ambiente di sviluppo IDE e Liferay Developer Studio piu facili e
potenti

« Ambiente di Sviluppo Sandbox

« Documentazione Migliorata:
— Liferay in Action
— Corsi Certificati in Italia
— Guide Ufficiali:
« Guida dello Sviluppatore
« Guida estesa sull'utilizzo di Liferay
— Javadocs di alta qualita

WWW.LIFERAY.COM = LIFERAY.



Web Service Migliorati

 Web Service JSON piu potenti e flessibili
— Generati automaticamente con Service Builder
— Controllo mediante annotazioni
* Protocollo Atom Publishing Web Services
— Blog
— Document Library file and cartelle
— Contenuti Web
— Utenti (sola lettura)

WWW.LIFERAY.COM = LIFERAY.



Miglioramenti nei Temi

* Impostazioni Personalizzabili p«
gli amministratori dei siti —

¢ CheCkbOX ‘ g m 7' , Description

Portlets, themes, and layout templates

Current Theme

° included with Liferay Portal.
Select iy

* Text : —

Color Schemes (3) —
* Textarea .
« Custom |

Blue ~  Green - Orange
Settings =

« SASS per styling modulare CRven
dei CSS < o ] )
v t Borders by Default
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Grazie per
I’attenzione
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